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The focus of this project was to develop a manual to 

assist teachers in the training of fellow teachers on the 

management of student records. The program creates a time 

saving method in the training of a computerized gradebook 

found within the trACE™ program. The gradebook component of 

the trACE™ program offers a variety of report formats which 

assist with classroom organization and instructional 

planning. Included are lesson plans that show the training 

procedures for this project. 
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CHAPTER 1 

Background of the Study 

One of the current trends in education being 

investigated by many school districts is Outcome Based 

Education (OBE}. A key component in OBE is the integration 

of curriculum objectives, student outcomes, and tracking of 

student progress in achieving educationl objectives. Rubin 

and Spady (1984) defined OBE as a teaching method: 

in which the specific learning achievements of 

students-rather than predetermined time and 

schedule factors-govern their placement and 

movement through the curriculum. (p. 38) 

This push for OBE is a result of the concern of most 

teachers, administrators and parents, of any school or 

district, with the final product or learning outcomes of 

their graduates. Though this concern is not new in 

education, currently there has been more effort spent on 

identifying what students really need to have (skills, 

knowledge, etc.) when they leave the school system. Through 

these efforts and research the phrase OBE has become a 

concept for curriculum, assessment and evaluation of what we 

do in schools today. Each OBE system takes on the needs of 

a school district using concepts of each system that appeal 

to the individual school district's needs. one component of 
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OBE and the focus of this project is record keeping and 

grading. 

One effort for record keeping in OBE began in 1983, 

when the Alpine School District of American Fork, Utah, in 

an effort to restructure curriculum, initiated its own form 

of Outcome Based Education. Over the next four years, 

curriculum committees were formulated to evaluate and update 

objectives to be implemented and the strategies that could 

be used to meet those objectives. "It became evident almost 

immediately that the cost of filing, reproducing, and 

updating these strategies would be prohibitive" (Alpine 

Board of Education, 1990, p. 1). 

The initial step taken to remedy this situation was the 

formulation of a computerized gradebook program for the 

Apple Ile. In 1987 with the introduction of the Macintosh 

computer, a way was found to "more efficiently manage the 

curriculum" (Walton, 1991). 

According to Page (1988): 

Because computers are fast, accurate, and reliable 

in performing tedious, repetitive tasks, they have 

been heralded as the solution to problems relating 

to the management of individualized instruction, 

programmed learning, mastery learning, outcome based 

education, and other instructional processes which 

depend upon a management system to control the 

2 
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content, context, duration and pace of instructional 

events. (p. 546) 

Utilizing technology, Alpine School District personnel 

developed a computerized curriculum resource for teachers. 

Additional teacher input formed the basis for the existing 

trACE™ program including its record keeping component. 

Concerned with the outcome of its graduates, the Cle 

Elum-Roslyn School District of Cle Elum, Washington, began 

its own efforts at restructuring with the development of 

"Creating the Future" project. As part of the project, 

leadership teams consisting of staff, parents and community 

members established goals for the district for the 21st 

century. These goals were prioritized with emphasis placed 

on the top three for the 1991-1992 school year. 

The top three were: 

1) students will possess the academic skills necessary to 

succeed in a global society. 

2) Develop the communication skills and attitudes essential 

for constructive interaction with others. 

3) Build qualities essential for a positive self-concept 

(Cle Elum-Roslyn School District, 1991, p.14). 

District level strategies to achieve the goal of academic 

skills necessary to succeed in a global society included, 

establishing a committee to explore OBE and sending district 

representatives to investigate the trACE™ program. 
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Statement of the Problem 

In the Cle Elum-Roslyn School District, investigation 

of the trACE™ program resulted in a pilot program within one 

classroom at Walter Strom Middle School. The introduction 

of technology in a classroom, building, or district requires 

not only cooperation, but a commitment and investment of 

time by staff members to follow through with training, 

implementation, evaluation and reassessment. Historically, 

one of the problems of integration of technology in 

education has been technological literacy of those involved 

and addressed a need. However, training educators to learn 

a program, should not be the purpose of the program, but 

must be used to fulfill a need. The function of trACE™ was 

to fulfill the need of accessing student grades, progress 

reports and report cards. As the need grew for more 

teachers to know the system it became necessary for training 

in the use of trACE™. Because the Alpine School District 

has placed all of its focus on the development of the 

program, the user's guide is not conducive to meeting the 

needs of the teachers of Walter Strom Middle School. The 

resultant problem is that there are no procedures for the 

training of teachers to utilize the trACE™ program at the 

Walter Strom Middle School of the Cle Elum-Roslyn School 

District. 



Purpose of the Project 

The purpose of this project was to develop a manual to 

assist trainers in the instruction of the trACE™ program 

within the Cle Elum-Roslyn School District, which will be 

utilized as a reference when training is complete. 

Procedures 

5 

After researching the literature on OBE, utilizing the 

components of the trACE™ program through training and 

piloting, a manual of procedures for the training of 

teachers was developed. The manual and training were 

presented in sections, with ample time in between for 

reinforcement of procedures covered in training. This added 

practice made the trACE™ program easier to use. It created 

a management tool for the teacher and a learning environment 

for students. The manual contains the Gradebook component 

of the program. 

Limitations of the Project 

The development of the trACE™ program is in its 

beginning stages, therefore, resources available for review 

of the literature were limited. Recorded interviews of key 

people within the Alpine School District were used as 

primary resources. During the researching phase, the 

acceptance of trACE™ by the Middle School Staff was a 



concern because of misconceptions about the purpose of the 

program. 

Definition of Terms 

The following terms are defined to clarify meaning for 

the reader. Where there were insufficient definitions to 

clarify these terms, the researcher defined the terms. 

Consortium -

A coalition of educators using trACE™ and 

contributing their own ideas to the program. 

Creating the Future -

II •. a process of developing a long range Direction 

6 

of Improvement Plan for the 21st century," established 

as a cooperative effort by the Cle Elum-Roslyn School 

District and the Northwest Regional Laboratory (Almlie 

MacMurdie, 1991, p. 1). 

Instructional Theory into Practice (!TIP) -

II elements of effective instruction incorporated 

into a lesson design containing eight steps" (Jones, 

1981, p. 253). 

Mastery Learning -

11 
••• an instructional process. It involves 

organizing instruction, providing students with regular 

feedback on their learning progress, giving guidance 

and direction to help students correct their individual 

learning difficulties, and providing extra challenges 



for students who have mastered the material" (Gusky, 

1985, p. xiii). 

outcome Based Education -

7 

(OBE) A teaching method "in which the specific learning 

achievements of students--rather than predetermined 

time and schedule factors--govern their placement and 

movement through the curriculum" (Rubin & Spady 1984, 

p. 38). 

Outcome Driven Developmental Model -

(ODDM) "is a systems process through which we are able 

to get what we want intentionally by aligning our 

outcomes. What we do is aligned with best knowledge 

(research)" (Champlin, 1991, p. 3). 

Restructuring -

"· •• a unified, systematic approach to rethinking 

curriculum and instruction, authority and decision 

making, staff roles, and accountability" (O'Neil 

1990, p. 6). 

trACE™ -

(teacher resources to Achieve Classroom Excellence) 

A computerized instructional support system 

(Alpine School District Board of Education, 1991). 



CHAPTER 2 

Review of the Literature 

A review of the literature for this project shows that 

education is in a constant process of change. A current 

evolutionary cycle of research related to the public 

educational system encompasses Restructuring and outcome 

Based Education. Within the Restructuring and outcome Based 

Education, published literature shows both Mastery Learning 

and Record Keeping are addressed as components of these 

current issues. 

The Superintendent of the Cle Elum-Roslyn School 

District in Cle Elum, Washington, alluded to restructuring 

when he said: 

Some questions every school district must ask itself 

are: 

Where are we headed in the future? What kind of 

educational program will we need to provide our 

students with in the future, so they can compete not 

only in our local community but in a global community? 

Is what we are currently doing adequate in terms of 

what students must know in the 21st Century? (Almlie, 

1991, p. 1) 

8 
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Restructuring 

Restructuring is defined as "a unified, systematic 

approach to rethinking curriculum and instruction, authority 

and decision making, staff roles and accountability" 

(O'Neil, 1990, p. 6). 

In the past, reform took place in small parts. 

Restructuring requires all parts of the educational process 

to change. This alteration must take place "from students 

and teachers up through the myriad bureaucratic layers to 

the nation's capital" (David, 1991, p. 11). 

During 1991-92, Washington State legislators spent many 

hours debating mandated restructuring and "performance

based" instruction. The result was Senate Bill 5953 which 

speaks directly to the demand for state wide restructuring 

and to the legislative intent for performance-based 

instruction: 

The legislature finds that: a) academic achievement of 

Washington state students can and should be improved; 

b) student success in large part depends on parents' 

involvement both at home and at school in the education 

of their child; c) many school districts across the 

state are engaged in efforts to re-evaluate and 

restructure their local education programs; d) state 

support can help sustain and accelerate the momentum of 

educational restructuring initiatives. 
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The legislature recognizes that the public education 

system as the foundation of our society faces critical 

issues that reflect the public's increasing concern 

regarding the effectiveness and accountability of our 

public schools. The legislature finds that these 

issues can be addressed by: a) increasing public 

confidence in the professional preparation and training 

of educators; b) establishing rights and 

responsibilities of parents to knowledgeably 

participate in the education of their children; c) 

measuring and reporting student achievement in a manner 

that encourages accountability to an understanding by 

the public; d) increasing the broad powers and 

accountability of school boards; e) establishing a 

state-level panel to monitor and report on the progress 

of educational reform and restructuring efforts 

throughout the state {Almlie, 1993, p. 2). 

This legislation caused a change in high school 

graduation goals. 

An excerpt from the June 8, 1992, edition of the 

Washington State Senate Education Commission Update" reads: 

Student Learning Goals for Students of Washington 

The ultimate goal of Washington's K-12 Education system 

is to enable people to be responsible citizens, to 

contribute to their own economic well-being and to that 
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of their family and community, and to enjoy productive 

and satisfying lives. To these ends, schools, together 

with parents and communities, will help students 

develop the knowledge, skills and attitudes essential 

to: 

Goal 1: Communicate effectively and responsibly in 

a variety of ways and settings; 

Goal 2: Know and apply the core concepts and 

principles of mathematics; social, physical and 

life sciences; arts and humanities, and healthful 

living. 

Goal 3: Think critically and creatively and 

integrate experiences and knowledge to form 

reasoned judgement and solve problems. 

Goal 4: Function as caring and responsible 

individuals and contributing members of families, 

work groups, and communities (Iwasaki, 1992, p. 

A17}. 

These provisions place performanced-based legislation 

on the House and Senate's doorsteps for the 1993 legislative 

session. It is anticipated that a major restructuring bill 

will pass and will be signed into law by the new governor 

(Almlie, 1993}. 

To create an environment of change, Washington State 

Representative, John Betrozoff (1992) believes that "best 
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practices and research that work must pervade the change 

process." (p. 14) Adam Urbanski (1990), president of the 

Rochester Teacher's Association, addressed the challenge of 

restructuring "as making the terrific exceptions that now 

appear in nearly every school district the norm, not the 

exception." (p. 5) Ron Brandt (1990), Executive Editor of 

the Association for the Supervision of Curriculum 

Development, concurring with this challenge stated that 

"schools need to be the best place for the young people who 

attend them." (p. 1) Each alluded to the process of 

restructuring as bringing about more effective schools. In 

support of this Jane L. David (1991), Director, Bay Area 

Research Group, states "the goal of restructuring education 

is to raise significantly the performance of all students." 

(p. 14) 

Outcome Based Education 

The concept of Outcome Based Education originated in 

the Johnson city School District in New York during 1991. 

Johnson city developed an approach called the outcome Driven 

Developmental Model (ODDM). Through this model, districts 

are challenged to "look at the whole of their organization, 

not just the parts" to establish that they are organized to 

effectively achieve what they want (Champlin, 1991, p. 34). 

ODDM is a process for making all schools more effective 

by insuring that the conditions exist in which all people in 

schools, students, teachers, and administrators can discover 
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and develop their potential as they serve the school's 

mission. ODDM, as well as OBE, embraces the entire process 

of comprehensive school improvement for a cohesive community 

of renewed and growing professionals who share a clear 

mission, act on common values and beliefs, and execute 

procedures for helping all students achieve excellence. 

Outcome Based Education (OBE) pulls together proven 

elements of good teaching, learning, assessment and 

management of schools into an effective system "that 

empowers every individual in the system to achieve 

excellence" (Champlin, 1991, 34). It is both a 

researched-based and decision-making model that leads staff 

members through the process of deciding why we teach what we 

teach and how to go about it, a comprehensive process to 

examine all facets of school operation. There are three 

underlying beliefs of OBE leading the philosophical and 

instructional decisions: "All students can learn, Success 

breeds success, and Schools control the conditions of 

success" (Spady & Marshall, 1991, p. 67). 

OBE forces educators to express what is valued, to 

commit educational resources and "to continue until we have 

succeeded'' (King & Evans, 1991, p. 74). This success is 

based on the belief that all students can learn, at a high 

standard of performance. The key to outcome Based Education 

is "getting kids to the desired performance levels, not the 

amount of time it takes them to get there" (Brandt, 1991, p. 



57). Students are expected to achieve exit outcomes, but 

they need not get there by the same path (O'Neil, 1992). 

14 

Individualized instruction allows students the time 

necessary to master concepts prior to proceeding to the 

next. "Students vary in the amount of time needed to 

successfully achieve or complete a task, and that nearly all 

students can achieve if given sufficient time" (Carroll, 

1963, p. 723). Teacher's judgement and student needs 

influence instructional time for different learners. Many 

researchers call this process mastery learning. Gusky 

(1985) provides the following definition of mastery 

learning: 

In essence, mastery learning is an instructional 

process. It involves organizing instruction, providing 

students with regular feedback on their learning 

progress, giving guidance and direction to help 

students correct their individual learning 

difficulties, and providing extra challenges for 

students who have mastered the material (p. xiii). 

The limiting factor in the implementation of mastery 

learning most commonly mentioned is time. Increased 

responsibility is placed on the teacher in the following 

areas: individualizing student instruction, monitoring 

student work, determining what skills have been mastered, 

providing feedback, and organization of record keeping 



(Towers, 1992, p. 298). 
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Another limiting factor of Mastery 

Learning is not allowing teachers enough time to plan and 

work together to ensure the success of students (Nyland, 

1991, p. 32). Although there are limitations, studies have 

shown the effectiveness of mastery learning. 

A review by Block and Burns of over two dozen studies 

conducted between 1971 and 1976 has provided evidence 

of the effectiveness of mastery learning. They chose 

18 studies that were conducted in an actual school 

setting and used school-like learning tasks, based 

largely on textbook material. Block and Burns found 

that 61 percent of the time, mastery-taught students 

scored significantly higher on achievement tests than 

non-mastery taught students. For retention intervals 

lasting a few weeks to several months, mastery-taught 

students showed a higher degree of learning and 

retention than non-mastery-taught students in about two 

thirds of the comparisons (Towers, 1992, p. 296). 

During the early pioneering of OBE in Johnson city School 

District statistics showed that, 

44% of all eighth grade students scored six months or 

more above grade level in reading; in math, 53% scored 

at this level. In 1984, 75% of all eighth graders 

scored six months or more above grade level in reading. 



In math, 79% scored six months or more above grade 

level (WSNOBE, 1992, p. 4). 
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Students going through Johnson City school increased 

their applications to four year institutions and high-status 

schools like Harvard and Yale. According to Vickery (1988) 

part of a successful OBE is that "students' aspirations 

levels are rising, as reflected in the number who take 

advanced placement courses and college admissions tests and 

in the number who win the New York State Regents' 

scholarships. 11 (p. 56) 

Spady (1991) believes that schools control the 

conditions of success. Towers (1992) reinforced this 

thought by quoting Burns and Wood (1989) who stated that for 

OBE to be successful, teachers must be allowed the 

flexibility and time to create the conditions for student 

success. Burns and Wood felt to support this concept the 

administration's role is best described as: 

It would be helpful for the administration to have an 

idea of the perceptions of teachers regarding the 

proposed innovations and take those into account when 

making plans for the implementation. Top-down 

decisions about the program being carried out are more 

likely to produce undesirable side-effects and minimal 

recipient satisfaction. Neither top-down or bottom-up 

but rather collaborative planning by teachers and 
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administrators results in more effective implementation 

of resulting plans (Towers, 1992, p. 302). 

The importance of a belief system cannot be 

underestimated, it can help produce and endure motivation 

for change. outcome Based Education breaks the paradigms on 

many standard educational beliefs. For example, the 

following chart adapted from the Bremerton School District 

(1992) illustrates a few of those beliefs: 

Traditional Beliefs 

Natural Selection 

Remediation Programs 

Competitive Learning 

Success for a Few 

"Mystery" Learning 

"One-shot" Tests 

Calendar-Driven 

Textbook-Driven 

Outcome-Based 

Talent is developed 

Prevention Programs 

Cooperative Learning 

success for All 

Mastery Learning 

Reteach and Retest 

outcomes-Driven 

Values/Beliefs Driven 

Towers believes that "for successful implementation of 

outcome Based Education there must be a commitment from all 

individual stakeholders." He also believes that 
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establishing a comprehensive building-level plan is 

essential (Towers, 1992, p. 302). 

Burns (1987) suggests when developing a comprehensive 

building-level plan, it should contain five major 

components. 

1. Organize Instruction. Choose an instructional model 

(e.g., "whole-class mastery," "flexible grouping," 

"individualization," or some combination) which is best 

suited to school's size, faculty, priorities, environs, 

resources, etc.). 

2. Aligned Curriculum. In an aligned curriculum, where 

what is tested is what is taught, there is close 

coordination between the testing program of the 

district and the curriculum of the school. 

3. Instructional Delivery. Once students are organized 

for instruction over some segment of the curriculum, 

they need to be taught. Staff development becomes 

critical at this juncture. 

4. Administration. A building-level plan for mastery 

requires administrative support, but do not attempt too 

many changes at once. The prudent administrator will 

plan policy change so that it unfolds over time and 

matches the required mechanics of the instructional 

model implemented. 

5. Information Management. This refers to computer 

support, resource storage, test creation and item 
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banking, report production, and record keeping. The 

need for accurate and efficient information management 

permeates all facets of OBE (Towers, 1992, p. 303). 

The Cle Elum-Roslyn School District's belief that 

"communication with parents and community members is 

essential." In its Creating the Future project it was 

determined that interest in OBE addressed the need for 

accurate and efficient record keeping (Cle Elum-Roslyn 

School District, 1991, p. 21). 

Record Keeping 

One of the most useful tools for record keeping has 

been the use of computer technology. Branscum (1992) 

pointed out that "without computers, teachers spend a great 

deal of time on repetitive manual labor. That's time away 

from students." (p. 83) A comprehensive gradebook and 

other databases take time and expertise that most teachers 

don't have. "Using computers as a tool for manipulating 

information, for coping with a fast-changing society, and 

for thinking - can scare teachers" (Piller, 1992, p. 226). 

Page (1988) supports Piller in saying that "most 

computerized management systems are difficult to use, 

particularly for the novice, and require many hours of 

training before teachers will attempt to use the technology 

on their own." (p. 545) 
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Comprehensive gradebook programs are available and 

provide considerable time savings to an educator. Entering 

grades would take about the same amount of time if a teacher 

were to use a written gradebook or a computerized gradebook. 

However, the computerized gradebook takes care of everything 

automatically. For example, if a score needs to be altered, 

the teacher may change (edit) that score and the computer 

will instantly recalculate the student's grade. Vockell 

(1989) supported this when he stated, "the speed and 

accuracy of grade averaging are two of the greatest 

advantages of a gradebook program." (p. 356) 

Another advantage to teachers is that once the 

gradebook program is learned, he or she can operate the 

program quickly and keep accurate updated records. This 

enables a teacher to use technology to improve 

communication. "Many teachers feel that a gradebook program 

helps make them more organized" (Vockell, 1989, p. 356). 

This organization and the availability of student progress 

reports is of great benefit for parent conferences, grade 

justification, and to the students themselves. 

During the investigation of record keeping systems the 

comprehensive gradebook portion of the trACE™ program became 

a focus of the Cle Elum-Roslyn School District's 

restructuring process. The gradebook portion of the trACE™ 

program was developed by teachers "to provide relevant 

information about student progress to assist in making 
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educational decisions" (Runolfson, 1990). Standard grade 

information may be recorded, in addition to the program's 

ability to monitor student progress toward mastery of 

curriculum goals or outcomes. The teacher is able to modify 

and adjust instruction based on this feedback through the 

gradebook system of record keeping in trACE™. 

According to Vockell (1988) typical gradebook software 

programs: 

1) allow the teacher to enter grades as easily as 

with a written gradebook. 

2) permits easy alterations of previously recorded 

scores to correct clerical errors or to 

accommodate retests or rescoring of previous work. 

3) compute averages for an entire grading period. 

4) apply weighting formulas to grade computation 

(e.g. 50% test, 20% quizzes, 30% daily work). 

5) convert numerical grades to letter grades 

according to teacher generated standards. 

6) provide records of student's performance at any 

time during a grading period. 

7) give the option of entering a zero or "no grade," 

and averages are computed accordingly. 

8) show information such as mean, median and grade 

distribution on individual assignments. 

9) provide printed list of student performance. 
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10) flag students who don't meet teacher's expectation 

level. 

11) generate reports for individual students, 

including standard and individual comments. 

12) allow the reuse of names, or assignments without 

having to retype all the information again. 

13) support different grading methods (letter, points, 

percentage, pass/fail). 

14) create a grid for attendance or recording scores. 

15) allow for recording extra credit work. 

16) enable the ability to print out objectives that 

have been met or not been met for each individual 

student (Vockell, 1989, 358). 

Each of the above aspects of a gradebook system are found in 

the trACE™ Gradebook. 

Summary 

This chapter addressed three components of school 

reform: Restructuring, Outcome Based Education and Record 

Keeping. Outcome Based Education has contributed to the 

restructuring process in the belief that "all students can 

learn" and that "schools control the conditions of success" 

(Spady & Marshall, 1991, p. 67). This belief emphasizes 

that all aspects of the school facility must work as a team 

and be committed to the educational process. This process 

must include accurate and timely reporting of student 
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progress. This can be accomplished with the use of a 

computerized management system, which enables the teacher to 

effectively communicate with students and parents. 



CHAPTER 3 

Procedures 

Population 

The target population for this project was the fifteen 

teachers of Walter Strom Middle School in Roslyn, 

Washington. Since 1990, the teachers of Walter Strom Middle 

School have been using technology as a tool by posting their 

quarter grades in a database on a Macintosh computer. This 

database was then used to generate school-wide report cards. 

For some of the teachers the posting of grades formed the 

extent of their technological literacy. 

Training 

The author spent approximately 30 hours in a week long 

training session in the Alpine School District, learning the 

different aspects of the trACE™ program. 

During the time allocated for the Gradebook portion of 

the program, the many benefits of using a computerized 

gradebook were discussed. Most useful was the speed of 

grade calculations, student progress and generating of 

various reports. It became apparent the use of the 

gradebook could be helpful to classroom teachers as a time 

management tool. 

Additional training was provided for teachers through 

the use of the Activity Sheet and Test Generators from 

trACE™. The author learned through this training session 

24 
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how the ease and speed of these features exhibited 

advantages for classroom instruction and remediation. 

Interviews 

Tape recorded interviews were held at the trACE™ 

Development Center in American Fork, Utah, with the creators 

of the program to learn the historical perspective of trACE™ 

and how its use would benefit the staff at Walter Strom 

Middle School in Rosyln. Review of the data by the author 

aided in the development of the training manual. 

Piloting 

The author piloted the Gradebook portion of the trACE™ 

program within a sixth grade core classroom. Student grades 

were kept in a hand written gradebook and in the 

computerized gradebook. After a quarter of utilizing the 

computerized system, and experiencing its speed and 

accuracy, the hand written gradebook was terminated. 

Reports were generated to show student progress, current 

grade status, and mastery of different outcomes. 

The efficiency of this program and the reports produced 

led to inquiries from staff, parents and community members 

indicating a need for more knowledge of the trACE™ record 

keeping program. 
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Presentation 

Utilizing the software program, Aldus Persuasion, a 

slide show demonstration was developed to give an overview 

of the trACE™ program and a closer look at the Gradebook 

component. The presentation included setting up the 

gradebook, entering students, assignments, scores and a 

variety of reports that may be created with this 

information. 

This presentation was used to provide an update on the 

use of the trACE™ program to the Cle Elum-Roslyn School 

Board, the Walter Strom Middle School staff and the Walter 

Strom Middle School Parent Group. (Refer to Appendix A) 

Following the demonstration, Walter Strom Middle School 

teachers expressed an interest in pursuing computerized 

tracking of student progress. With the limited computer 

literacy possessed by some teachers it became evident that 

instruction would be needed for classroom teachers to 

implement the use of the trACE™ Gradebook. 

Instruction 

Utilizing the information obtained from training, 

interviews, piloting and presenting, lessons were created 

from the draft copy of the trACE™ manual. These lessons 

were then used as a tool for instruction. 

A class was offered to all personnel of Walter Strom 

Middle School. The class was an introduction to the 

Gradebook portion of the trACE™ program. The course 
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included the following units: Creating a new file; File 

set-up; Entering students; Entering assignments; Entering 

scores; and Printing of various reports. (Refer to Appendix 

B) 

Instructional Manual Development 

Class discussion and course evaluations led to the 

development of a training manual using computer software to 

enhance record keeping. Smith (1992) cites forty different 

models for systematic design of instruction. Though there 

has been different models of Instructional Design developed, 

the design that was used as a guideline for this project 

followed that set forth by Gagne (1992). The steps used to 

develop the manual found in Chapter 4 utilized the following 

stages: 

System Level 

1. Analysis of needs, goals, and priorities 

2. Analysis of resources, constraints, and alternate 

delivery systems 

3. Determination of scope and sequence of curriculum 

and courses; delivery system design 

Course Level 

4. Determining course structure and sequence 

5. Analysis of course objectives 

Lesson Level 

6. 

7. 

Definition of performance objectives 

Preparing lesson plans (ITIP) 
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8. Developing, selecting materials, media 

9. Assessing student performance 

System Level 

10. Teacher preparation 

11. Formative evaluation 

12. Field testing, revision 

13. Summative evaluation 

14. Installation and diffusion (Gagne, 1992, p. 31). 

This information resulted in refinements as presented 

in the final product within Chapter 4. 



CHAPTER 4 

Manual 

Results of the interviews, piloting, presenting and 

instruction provided the impetus for the manual development. 

The following manual has been developed as a guide for 

those individuals involved in the implementation of the 

trACE™ concepts in the Cle Elum-Roslyn School District 

classroom. 
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INTRODUCTION 

The Alpine School District in American Fork, Utah, in their efforts to 

restructure their curriculum developed an integrated software program to aid in 

the management of record keeping. The trACE™ program is a powerful 

computerized instructional support system, which contains the following 

components: Curriculum Navigator, Gradebook, Calendar Generator, Rollbook, 

and Activity Sheet Generator. 

This teacher training manual has been created to assist in the training and 

utilization of the gradebook component of the trACE™ program. 

The trACE™ Gradebook is a standard electronic gradebook with some special 

features. The gradebook is easy to use and personalized. The gradebook has nine 

report options including: grade and student summary reports with comments, 

objective reports and deficiency reports. 

This manual is presented in sections. A course outline is provided, followed by 

suggested lesson plans for each instructional phase of presentation. Each lesson is 

designed around Madeline Hunter's Instructional Theory into Practice (ITIP) 

method. 

(Jones, Vernon. (1987) Comprehensive Classroom Management, p. 252-255.) 



COURSE OUTLINE 

Lesson 1 - Getting Started 

Lesson 2 - Setting Up a New File 

Lesson 3 - Entering New Students & Comments 

Lesson 4 - Entering Assignments & Scores 

Lesson 5 - Viewing Information (Windows Menu) 

Lesson 6 - D.1plicating a Gradebook File Set-up 

Lesson 7 - Creating and Printing Reports 

Lesson 8 - Pull Down Menu Features 



LESSON 1 

Getting Started 

* INSTRUCTIONAL HINTS 
Have all participants in the file server as users with simplified passwords. You might want 
to have a sample file available in their folders to retrieve. Do not hand out material covered 
on lesson sheets until the independent practice stage of the lesson. 

1. Anticipatory set 
Are you ready for a time saving tool in tracking student progress ? 
How many of you currently use a computer? 
Do you use a single station or file server? 

2. Objective 
Students will be able to load the trACET"' program from a file server 
or a single station computer. In addition students will be able to save their work for 
future use. 

3. Directinstruction 
4. Modeling 

Demonstrate the steps necessary to "log on" to a file server and to save the work you 
have done. 

Demonstrate the steps need to create a new file at a single computer station and to save 
the work you have done. 

5. Monitoring to check for understanding 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 

Step 1: Have all participants "log on" to the file server. 
Step 2: Have participants save the file to the file server and to a disk. 

7. Summary 
Discussion to establish trouble spots. 
Summarize the steps taken to retrieve and save information. 
Review any concepts covered which are unclear. 

8. Independent Practice 
Hand out Lesson sheets which follow for participants to practice material covered. 



trACE™ Teacher Training 

GETTING STARTED 

IF USING A FILE SERVER 

You must "Log on" 

< represents clicking 
mouse once 

« represents clicking 
mouse twice 

to the File Server. Connect to the flle server '"Walter Strom FIie 
Seruer" os: 

The screen will look like this: 

Enter your code hit TAB. 
Enter your name hit RETURN. 

« File Server 

« Staff folder 

0 Your Name « Your Name 

Q UUOi-t 

® Registered User 

Name: I Enter Nome Here 

Password: U \ (Scrambled) 

Cancel ( Set Possword) I( OK JI 
v2.0.2 

• Imm 

• « Gradesheet you want • um 
Saving your Work 

· Edit 
New 
Open ... 

Close 
S11ue 
Saue Rs ... 

Sort 01 
XN 
XO 

XS 

Import Students 

Page Setup ... 

Quit XO 

Select Save As ... from File menu. 

To File server 
will appear as 
shown 

< Save 

To a disk 
insert disk 
Type file name 

< Save 

I~ Your name I 

Saue file as: 

!d c.:::, FIie Seruer 

2.6 MB 
Free on disk 

E,jec1 

Driue 

"' 

S11ue 

Cancel 
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IF USING A SINGLE STATION (your own MAC) 

If no file exist you must load the Gradebook portion of the tr ACE™ program. 

« Hard drive 

.. 0 kACE™ « trACE™ icon 

<SI tr ACE™ Gr adeBook 1 .2 

« trACE™ Gradebook 1.2 

tr ACE™ Gr adeBook 1 .2 

A new file is ready ! 

****************************************************************** 
If a file already exists - insert disk where file is saved. 

« Hard drive or your data disk 

« File you wish to work with 
****************************************************************** 

Saving your Work 

Edit Sort 01 
New XN 
Open ... XO 

Close 
Soue XS 

Import Students 

Poge Setup ... 

Quit XQ 

Select Save As ... from File menu 

To Hard drive 
« folder to be placed in 

« Untitled box 
Type file name 
< Save 

To a disk 
Insert disk 
Type file name 
< Save 
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LESSON2 

Setting Up a New File 

* INSTRUCTIONAL HINTS 
Setting up a file is the first step in creating a new gradesheet. 
Have all participants use the SAMPLE file given to go through the Guided practice. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 
Have all participants bring class lists and standard comments to be used in student 
reports for next lesson. 

1. Anticipatory set 
Review what was covered in Lesson 1. 
Have students load SAMPLE file. 

2. Objective 
Students will be able to set-up a new gradebook file including customizing a grade scale, 
establishing a password, categories and preferences. 

3. Direct Instruction 
4. Modeling 

Demonstrate the steps necessary to Set-up a new file. 
I) Choosing Set-up from Options menu 
2) Customizing Grade scat-, 
3) Establishing Password 
4) Selecting Course Categories 
5) Selecting Preferences 

5. Monitoring to check for understanding 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 

Have all participants: 
I) Choose Set-up from Options menu 
2) Customize Grade scale 
3) Establish a Password 
4) Select and add course Categories 
5) Select Preferences 

7. Summary 
Discussion to establish trouble spots. 
Discuss relevance to each individual gradesheet to be set up. 

8. Independent Practice 
Hand out Lesson sheets which follow for participants to practice material covered. 



SETTING UP A NEW FILE 

1. Select Set-up from Options menu. 

Grode Scole District I 
i===========a 

Recalculate A+ School 

A 95 Teacher 
A- 90 
B+ 85 

:=======~ 
Subject 

B 80 Course ID 

Create Key ... B- 75 

% 

% 

% 

% 

% 

% 

% 

% 

% 
% 

% 

% 

Find Student... XF 
C+ 70 
C 65 

c- 60 
D+ 55 

[ Password ... ) 

(Categories ... ) 

[ Prefs... ) 

D 50 
0- 45 
F 0 [ Cancel ) I( OK ll 

Using the TAB key to move to each field 

2. Enter information as you would like for it to appear on reports. 

3. Customize the Grade Scale 
• Letter grades as well as 0/S/U or P/F may be used. 
• Enter lowest percentage for each grade. 

4. < ( Password ... J 

• Enter your unique password for entry into gradesheets. 
The computer will ask for you to re-enter, prior to accepting the 
password. 

5. < [ Categories ... J 

You will need to decide what categories you would like for each 
subject. 
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Categories 

Wt. Category Name 

EJ Weight 

Total Weight O 

@=] Number of High scores to drop 

@=] Number of Low Scores to Drop 

D Make Highest Score the MaHimum 

D EHtra Credit Category 

( Delete 

( Undo Changes ( New 

Cancel l € Rccept 

Using the TAB key to move to each field 

A. Enter name of category. 

B. Enter weight 
1) Ratio 
2) Percentage (must total 100) 
3) Total points (single category - weight 1) 

l 
D 

4) You may create a category which is weighted O (zero), if 
you would like to scores entered but not calculated into the 
final grade. {pretest} 

C. D Number of High scores to drop 

D Number of Low Scores to Drop 

Enables you to drop scores prior to calculation of grade. 
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or 

< 

D. D Make Highest Score the MaHimum 

E. 

If you want the highest score earned to become "total possible" 
for calculation of the grade. 
{ eg. 90 out of 100 receives 100%, 45 would receive 50%} 

D EHtra Credit Category 

< in box to select extra credit category. 
Name category extra credit. 

Points in the extra credit category can be assigned by: 

1. Maximum is Total of Assi nments 

Wt. Category 
+25 Homework 
+25 Quiz 
•SO Tests 

1 EHtra credit 

Total Weight 1 00 

~IE_H_tr_a_c_r_e_d~l~~~~!Name 

o==J Weight 

o MaHlmum Points 

~ Manlmum Is Total of Assignments 

181 EKtra credit category 

[ Delete 

[ Undo Changes [ New ) 

Cancel I( Accept I 

2. You can establish the maximum earned ooints. 
< in box D MaHimum is Total of Assignments 

Wt. Category 
+25 Homework 
+25 Quiz 
+50 Tests 

1 Entra credit 

Total Weight 100 

j ~E_H_tr_a_c_r_e_d_lt~~~IName 

o==J Weight 

~ M11udmum Points 

D MaHlmum Is Total of Assignments 

[8] EHtra credit category 

[ Delete 

[ Undo Changes [ New ) 

Cancel lj Accept H 

~n __ n_c_c_eiiipiat--#D to register your choices. 
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< ( Prefs ... l 
The following box will appear: 

Set the preferences for this file: 

t8l E11tro-credit warning 
t8l Beep at end of row/ column 
D Rt end of row/col. jump to ne11t 

0 Show column number 
@Show assignment name 

D Show student position number 

O Show student ID 
@ Show student name 

~ Default possible score 

I 10.00 I (%) Default e11p. leuel 

[ Cancel ] t OK )] 

A. Extra credit warning 
• alerts you that a score entered 

is beyond number possible. 

B. Beep at end of row/column 
• Beep sounds when you reach the end 

of a row or column. 

C. At end of row/col.jump next 
• cursor moves to next row or column 

when end of row/column is reached. 

D. Select column heading (<in circle) 
1. Show column number 
2. Show ;.;ssignment name 

E. Show student position 
( < in box to select) 

F. Show by student ID or name 
( < in circle of choice) 

G. Default possible score 

.__ __________ __., H. (%) Default exp. level 

< (( OK l] or RETURN to register these Preferences. 

You will return to the Set-up box. 

< [( OK l) or RETURN to finish Set-up. 

You will now be back to your grade sheet file. 
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LESSON3 

Entering New Students & Comments 

* INSTRUCTIONAL HINTS 
Have all participants bring class lists and any standard comments to be used in student 
reports. Have a listing of your student body and assign each an ID number. 
Have all participants use their SAMPLE file to go through the Guided practice. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 

I. Anticipatory set 
Review what was covered in Lesson 1 & 2. 
Have students load SAMPLE file. Check report information, grade scale and categories. 
Brainstorm standard comments that would be used for student reports. 

2. Objective 
Students will be able to enter new students, new comments and assign comments to 
students. 

3. Directlnstruction 
4. Modeling 

Demonstrate the steps necessary to Enter New Students & Comments 
1) Choosing New Student from Edit menu 
2) Entering names 
3) Entering ID (stress importance of each student having a unique ID number) 
4) Selecting Edit Comments ' 
5) Entering comments to be used 

5. Monitoring to check for understanding 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 

Have all participants: 
1) Choose New Student from Edit menu 
2) Enter names of students from their class list. 
3) Enter ID (provide Unique ID numbers for school's student body) 
4) Select Edit Comments 
5) Enter comments to be used 

7. Summary 
Discussion to establish trouble spots. 
Discuss relevance of each individual student having a unique ID number. 

8. IndependentPractice 
Hand out Lesson sheets which follow for participants to practice material covered. 
Have all participants have class list ready for next lesson and bring hand written 
gradebook with assignments and scores listed. 



ENTERING NEW STUDENTS 
Sort Options RI 

Ne111 Student i\.T 

1. Select New Student from Edit menu. 

Using the TAB key to move to each field 

Enter Student names 
Enter Student ID * 

New Assignment XB * The Gradebook program uses student ID, 
not name, to identify students. 

Edit Categories 3€6 
Edit Comments XM 

Each Student ID must be unique to that 
particular student. 
(a list of Walter Strom student numbers attached) 

Individual and Standard Comments 
are addressed below. 

ENTERING COMMENTS 
Sort Options R1 

New Student 34:T 
New Rssignment 34:B 

Edit Cotegories 34:G 
Edit Comments .lf.M 

1. Select Edit Comments from Edit menu. 

2. Type the comment in the text window. 

<( New 
J to enter additional comments 

or 

< ([ OK )) to exit. 

** To personalize comments you may use: 

FNAME - student's first name will be printed. 
LNAME - student's last name will be printed. 
ENAME - entire student's name will be printed. 
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ASSIGNING COMMENTS TO STUDENTS 

1. « Student Name 

2. < on each student comment you want for that particular student, 

it will be highlighted.(< highlighted comment to deselect) 

3. If you would like an individual comment unique to this student, 

< in the individual comment box, and type the comment. 
(limited to 255 characters) 

4. < n Rccept D to assign the comments to that student. 
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LESSON4 

Entering Assignments & Scores 

* INSTRUCTIONAL HINTS 
Have all participants bring hand written gradebook with assignments and scores listed. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 

I. Anticipatory set 
Review what was covered in Lesson 3 and any aspects of the program which are unclear. 
Have students load file. Check student listing and comments entered. 

2. Objective 
Students will be able to enter new assignments and enter scores for those assignments. 

3. Direct Instruction 
4. Modeling 

Demonstrate the steps necessary to Enter New Assignments & Scores 
1) Choosing New Assignment from Edit menu. 
2) Entering assignment information. 
3) Selecting category type for assignment. 
4) Entering several asssignments at one time. 
5) Entering scores earned on assignments. 

5. Monitoring to check for understanding 
Review letter scores and their result in the final calculation of the grade. 
Stress importance of attaching each assignment to a category. 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 

Have all participants: 
1) Choose New Assignment from Edit menu. 
2) Enter assignment information. 
3) Select category type for assignment. 
4) Enter several asssignments at one time. 
5) Enter scores earned on assignments. 

7. Summary 
Discussion to establish trouble spots. 
Discuss numerical and letter scores that are accepted by program and the results of 
those letter score in the final grade calculations. 

8. Independent Practice 
Hand out Lesson sheets which follow for participants to practice material covered. 
Have all participants enter all assignments for this given class and the scores earned by 
each student. 



ENTERING ASSIGNMENTS 

Sort Options n, 

New Student XT 
Ne111 Rssignment :!l B 

Edit Rssignment 
Edit Categories 
Edit Comments 

XG 
XM 

Delete Rssignment 

Fill Scores ... a€[ 

1. Select New Assignment from Edit menu. 
( or « the column heading) 

Assignment # LJltJ 
Cotegory: 

Assignment Nnme I New Assignment 

Dote l=! 2=/1=6=/9=3===~ 
Points Possible ! 1 DO 

l======~ 
DRILY WORK 
QUIZZES 
TESTS EHpectntion Leuel (%) ~11_0._oo ____ ~ 

I Clenr I[ Objectlue ... ] (no objectlue) 

Info ... 

[ Undo Chnnges J New J 

[ Edit Cotegorles ... I [ Cancel RII ] H Rccept B 

Using the TAB key to move to each field 

2. Enter Assignment Name 
3. Enter date for the assignment 
4. Enter points possible 
5. Enter expectation level(%) 

(minimum performance which demonstrates 
student understanding) 

6. < the category this assignment is part of. 

7. If you are entering several assignments 

< (~_N_e_w _ _,] 

until all assignments are inputed. 

If you are done entering 

< n Rccept D 

** Clicking the Info button will give you a score distribution for that particular 
assignment. It can be printed. 
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ENTERING SCORES 

Scores can be entered vertically or horizontally. 

1. < input direction Input Dir•ction ~ ,,i, 

2. < cell where the first grade will be entered. 
Press RETURN or ENTER between scores. 

The following letter scores are accepted: 

Calculated in grade as a zero. 
A absent 
U unprepared 

Not calculated in the grade. 

E excused from assignment (I use this for Challenge) 
M expected levd is met 

Sort Options R, 

New Student :Jill 
New Assignment :lllB 

Edit Student 
Edit Assignment 
Edit Categories :lllG 
Edit Comments :lllM 

Delete student 
Delete Assignment 

fill Sc ores... :l€:E 

N expected level is not met 
Blank no entry 

If all students are receiving the same score you 
may use Fill Scores from the Edit menu. 

Setting scores for assignment # 1 

"P 14 - Multiplying" 

Fill scores with IO ~--~ 

( Fill All ) 

( ,._ _c_a_nc_e_l --J] (( Fill Unscored ]) 

3. Select Save from File menu to record 
information. 
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LESSONS 

Viewing Information 

* INSTRUCTIONAL HINTS 
Have all participants bring completed class lists including students, assignments and 
posted scores. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 

I. Anticipatory set 
Review what was covered in Lessons 2, 3, & 4. 
Have students load file. Check student and assignment information. Discuss the 
relationship between categories and assignments. 

2. Objective 
Students will be able to view gradesheet information by class scores, individual student 
summary or by categories. 

3. Directinstruction 
4. Modeling 

Demonstrate the steps necessary to View Information: 
1) Selecting each viewing choice from Windows menu. 
2) The ability to change student scores in either the class scores screen or at the 

student summary screen. 
3) The ability to change the category of any given assignment. 

5. Monitoring to check for understanding 
Discuss advantages of viewing information in each of the three ways presented. 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 

Have all participants: 
1) Select each viewing choice from Windows menu. 
2) Change student scores at the class scores screen. 
3) Change student scores at the student summary screen. 
4) Change the category of any given assignment. 

7. Summary 
Discussion to establish trouble spots. 
Discuss advantages of viewing information in each of the three ways presented. 

8. lndependentPractice 
Hand out Lesson sheets which follow for participants to practice material covered. 
Have all participants review the use of the three viewing screens. 



WINDOWS MENU - The windows menu gives you three options. 

1. Class scores 

Student Summary 3€2 
Categories 3€3 

Displays the grade sheet screen as you see 
when you open the file. Students 
assignments, grades, and scores are visible. 

Student 1 1 A 
·stlident" 2 · · · · · · ······Ts~··· 
· student. i · · · · · · · · · · · · T c · · · · 
· stiicient· 4 · · · · · · · · · · · · T ·i>.:: · · 
:$~~:~~~f ~::::::::::: :T f::: 
. ~~u.~~n\ ? ............. J ~ ... . 
Student 7 ! B+ 

:$!~:d~~f ~::: :: : : : : : : : : ::: P.:::: 
Student 9 ! C+ ·;o .................... T ..... . 
· i.i · · · · · · · · · · ·· · · · · · · · · T · · · · · · 
·i2····················T······ 
. ~ ·..;. .................... ·:· ..... . 

lllindod.1s 

demo.manual - Class Scores 

24i Si 20i 18i 20i 100! 20! 5i 35! 12! 14i 23 
· · · i ·i/ · · · · ·,f · · · i + .. ·i's:·· ·if· .. 'i:i! · · · i i1 · · · · ·s: ···if··· i'ci1 · · · i'f · · · 23 
···:if···· t · · · ;--f · · ·i·si · · · 2( · .. sif · · · i'f · · · · ·11 · · · 2f · ·· "{ · · · · ·1: · · ·2°:3 
···if···· ·f · · · :?°01 ···it··· :ici\ · · · 91: · · ·; t · · · · ·s: · · · :lf · · · i':21 · · · i'ci\ · · · 23 
· · · · 31 · · · i'ci\ · · · i·f .. · i·a: · ··2t ····:;a:··· 201 · · · · f · · ·3,iJ · · · n: ···if··· 23 
· · ·z':f · ·· i ·oi · · · i'f · · ·i·{ · · · i'f · · · 9f · · · i'"f · · ·· ·:i! · ··i,i! · · · i'cil · · · i·si · · · 23 

: : 1t:::: :ii::: rii::: r~r: :rf i:: l~l::: i:ti::: ::~1:: 1~1::: i:~i :: : :::1:: 1~ 
· · · i's1 · .. ··a: .. · if··· i'lii · · · 21: ···sf··· i':i! · · · · ·,t ···if···· ·91 · · · i'f · · · 23 

:::::1:::J:::::J)::[::::1::::\J::::1:::::[::J:)J::::J:::::: 
2. Student summary 

This screen displays the final letter 
grade, weighted percent, and raw 
score for any particular student. 

( < student name) 

D demo.manual Student Summary 0 

Student 1 'li'- Letter Wei9hted Raw 

Student 2 - Final Grade: I A- I 90.05 I 09.26 I Category : I A 11 ~ 

Student 3 .. Title Date Ser Poss Ob i9il Mean Med. Cat Obiective 
Student 4 1 P 34 1 /27 /S 23 24 70.00 19.6 Z2.0C 1 
Student 5 2 P. 111 5-14 1 /27 /< 7 10 70.00 8.22 8.00 1 
Student 6 3 P 36 1 /28/' 20 20 70.00 18.3 19.01 1 
Student 7 4 p 37 1 /29/< 18 18 70.00 16.51 18.01 1 
Student 8 5 p.118-1191- 1 /31 /• 20 25 70.00 20.5 21.0 1 
Student 9 6 CHAPTER 3 TE 2/3/9: 91 100 70.00 84.3 90.01 3 

7 P.126-127 * 2/10/! 18 20 70.00 16.4, 17.01 2 
8 Assignment Sh 2/10/! 5 5 70.00 4.11 5.00 4 
9 CUMULATIVE R 2/10/S 37 40 70.00 30.31 30.01 2 

10 p.131 skills re 2/14/S 12 12 70.00 10.1 10.0( 2 
11 p.131 5-12; 1 2/14/! 10 16 70.00 11.31 12.5( 1 
12 P 40 2/14/S 23 23 70.00 22.5! 23.0 1 
13 P. 139 CHAPTI 2/19/S 18 20 70.00 18.1 • 18.0( 2 
14 p. 1 45 readin; 2/24/S 6 10 70.00 7.00 8.00 2 
15 p. 151 1-10 2/27/S 16 20 70.00 17.5( 18.0( 1 

~ rei 
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Scores can be changed on this screen. 

( < score to change, enter new information, press RETURN) 

** I use this sometimes to input late work and it is also great for showing students 
their present scores and how a score effects their overall grade. 

Lllindoms 
3. Categories Class Scores 3€ t 

Student Summary 3€2 
( ategories :~:3 

This screen displays all of the 
categories and their weights. 

ASSIGNMENT 

P 34 -0, 
P. 111 5-14 * = 
P36 = 

:.~;9-1191-3* iiiiii 

demo.manual - Categories 

25 TESTS 

P. 126-127 * -0, 
a.HJ.ATM: REVL.. 
p.131 s1c111s revew 
P.139Q-i/>PTER ... 
p. 145 roa1il:J ma1h 

(}i/>PlcR 31EST 

~1:~ 5-12; 132 ... mm 

UL....L.>LJL....L...J.."---'--0-.... .._ ____ _,_-0-'-' '-------'--'-' L..-----'--'-' "'"""""""""'""'"" 

Also displayed is each individual assignment in its respective category. 

Changes can be made at this screen or by using the Edit menu. 

Changing assignment position 
If assignment was placed in the wrong category, you can click and hold the 
mouse on the assignment title and drag it to the correct category box. 

Changing category information 
« Category title (the category box will appear) 

Make changes 

< [ Rccept D 
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LESSON6 

Duplicating a Gradebook File Set-up 

* INSTRUCTIONAL HINTS 
Have all participants bring existing gradesheet they have created. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 

1. Anticipatory set 
Review the Set-up of a new file. Have students load file. 
Review any aspects of the program covered which are unclear. 
Discuss _the need to have additional files, but how retyping all data or information is time 
consummg. 

2. Objective 
Students will be able to create a new gradebook file from an existing file. 

3. Directinstruction 
4. Modeling 

Demonstrate the steps necessary to create a new gradebook file from an existing file: 
1) Selecting a file which already exist. 
2) Selecting New from the File menu. 
3) Choosing what parts of the existing file you wish to appear in the new file. 
4) Selecting SA VE AS ... from File menu to name and rave this new gradesheet. 

5. Monitoring to check for understanding 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 
Have all participants: 

1) Select a file which already exist. 
2) Select New from the File menu. 
3) Choose parts of the existing file to appear in the new file. 
4) Select SA VE AS ... from File menu to name and save the new gradesheet. 

7. Summary 
Check new file for all information that was to be duplicated. 
Students, Categories, Assignments and/or Grade Scale. 
Discussion to establish trouble spots. 

8. IndependentPractice 
Hand out Lesson sheets which follow for participants to practice material covered. 
Have all participants create a gradesheet for each class taught. 



DUPLICATING A GRADE BOOK FILE SET-UP 

A new file can be created from an existing file. 

1. Open the file containing the information you wish to duplicate. 

2. Select New from 
the File menu. 

The following box appears: 

< In the D of those items 
you wish to have the same 
in your new file. 

Change the subject title 
if you wish. 

Choose the parts of this file to be 
copied to the new file 

D Rssignments 

D Students 

D Categories 

[8J Grade-Scale 

[8J Teacher, Password, Prefs, 
Standard Comments, and 
Course ID 

( Cancel J f[ OK I 

* You should then SA VE AS ... from File menu, to save your new file. 
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LESSON7 

Creating and Printing Reports 

* INSTRUCTIONAL HINTS 
Have all participants bring gradesheets they have created. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 

I. Anticipatory set 
Have students load a file. Review any aspects of the program covered which are unclear. 
Discuss the time saving factor in duplicating existing files, either for classes that the 
same students are in or different classes which have the same assignments given. 
Discuss the need to communicate this information to students and their parents. 

2. Objective 
Students will be able to create and print a variety of reports from their existing 
gradesheet files. 

3. Direct Instruction 
4. Modeling 

Demonstrate the steps necessary to create and print a variety of reports: 
I) Selecting a report to create from the Reports menu. 
2) Choosing gradesheet files to be included in the report. 
3) Choosing students to be included in the report. 
4) Procedure for printing, including paper saving option. 

Go over Report examples to explain the different report options available. 

5. Monitoring to check for understanding 
Discuss the different report options and the advantages of those reports. 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 
Have all participants: 

I) Select a report to create from the Reports menu. 
2) Choose gradesheet files to be included in the report. 
3) Choose students to be included in the report. 
4) Print selected report using paper saving option. 
5) Experiment with the different report options available. 

7. Summary 
Further discuss the different report options and the advantages/disadvantages of these. 
Discussion to establish trouble spots. 

8. Independent Practice 
Hand out Lesson sheets which follow for participants to practice material covered. 
Have all participants create and print a variety of report formats. 
* Include class roster in printing requirement. 



CREATING REPORTS 
Reports Windows 
Grade Report ... 
Student Summory .. . 
Objectiue Report .. . 

A variety or reports are available for 
you to create. 

Poper GrodeBook .. . 
Closs Roster ... 
Nomes on Scon Form ... 

Grade Report, Student Summary 
and Objective Report are created uses 
the same steps. 

Class summary by Category 
Assignment Summary ... 
Deficiency Report ... 
Student Objectiue Groups ... 

Files to include: 

1. Select the report you wish to create 
from the Reports menu. 

The following box will appear: 

lei CLASS-trACE™.,... I 
-0, [) CLASS LIST Q = Michele's HD 
c--

) «Add« 

( « Add All ] 

Cl ettperiment 
D HANDBOOK [ !: j(l( t 
D PICTURE FILE [ Desktop 
Cl sample 

[» fl(lrrl(ll'(l J u Open 

{> 
[Remoue All) [ Done 

- Cancel ,0. 

2. Select the Gradebook file or files to include in the report. 
> on file 

> [ << Rdd << ] 

if all gradesheets are to be added > ( << Rdd RII J 

> ( Done J 

D 
l 
l 
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Student box will appear: 

Choose students for which to generate a report 

Students to report: File: I demo.manua•I 

[ « fl(!(! ) 

[ << Rdd RII ] 

Student 1 .Q. 

( HPllHHH~ » ) 

f!(!Hl(ll'(~ fill 

[( Done D 
( Cancel ) 

Student 2 
Student 3 
Student 4 
Student 5 
Student 6 
Student 7 
Student 8 
Student 9 

-
-0-

~ Hide names already added 

3. Select the student or students to inch1de in the report. 
> student name 

> ( << Rdd << ) 

if all students are to be added > ( << Rdd RII ) 

> ( Done ) 

4. You now will have the following options to select: 

Grade Report - you may select a particular date for your progress 

Student Summary - you may select if you would like the class 
comparison and outcome descriptions to be printed. 

Objective Report - you may select above or below expectation for the 
report type. 
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5. Reports are then displayed. 

6. The Report viewer is located in the left corner of the screen. 
It has a paper saver option (which also saves time). 

[ Print }Cancel) E] ~ ! 1/13 1¢11111[ 

[ Print {Cancel) E] ~ ! 1/7 !¢Inn!::: 

7. > Print to send the report to the printer 
> Cancel to terminate printing or to return to your file. 

Attached find examples of various printed reports. 

Lesson 7 - page 3 



V Teach er: MRS. WONDERFUL 
V 
....,.. Grade Report for Student 1 

' )rt Period: 1 /27 /92 - 2/24/92 

Subject and Teacher 

MATH Grade: 

Current Report 

96.66% A 
MRS. WONDERFULClass Comparison: 83.86% 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 



..... 
'7 
...,. Student Summary Student 9 

S )ect: MATH 
Teacher: MRS. WONDERFUL 
Grade: 79.27% (C+) 
Class Comparison: 83.14% 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

(-) indicates the student did not meet the teacher expectation level on the marked assignment. 

Date Score Percent 
ASSIGNMENTS 

P 34 1/27/92 18/24 75.0 
P. 111 5-14 * 1/27/92 8/10 80.0 
P 36 1 /28/92 19/20 95.0 
p 37 1/29/92 18/18 100.0 
p. 118-119 1-3 * 1/31/92 21/25 84.0 
p.131 5-12; 132 10-17 2/14/92 15/16 93.8 
P 40 2/14/92 23/23 100.0 
p. 151 1-10 2/27/92 18/20 90.0 

QUIZES 
P. 126-127 * 2/10/92 12/20 60.0 (-) 
CUMULATIVE REVIEW 2/10/92 27/40 67.5 (-) 
p. l 31 skills review 2/14/92 9/12 75.0 
P. 139 CHAPTER CHECK 2/19/92 /20 
p. 145 reading math 2/24/92 3/10 30.0 (-) 

TESTS 
CHAPTER 3 TEST 2/3/92 82/100 82.0 

ASSIGNMENT SHEET 
Assignment Sheet 2/10/92 4/5 80.0 



~ Class: MATH 
T Objective Report for Student 5 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

-)e student has met the teacher level of expectation for the following objectives: 

~ Class: MATH 
T Objective Report for Student 6 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

The student has met the teacher level of expectation for the following objectives: 

l 

~ Class: MATH 
T Objective Report for Student 7 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

The student has met the teacher level of expectation for the following objectives: 

~ Class: MATH 
T Objective Report for Student 8 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

The student has met the teacher level of expectation for the following objectives: 



Student 1 ························ 
Sturl.ent 2 

.$1 )iiJ 
Student 4 ···························· 
Student 5 ··················· 
Student 6 
Student 7 
Student 8 
Student 9 
10 
11 
12 
73 

demo.manual (MRS. WONDERFUL) 4/7/1993 19:39 Page 1 

Method: Letter P 34 P. 11 P 36 p 37 p. 11- CHAP. P. 1 2 Assiqr CUMUI p. l 31 p.131 P 40 P. 1 3' p. 14 p. 1 5 · 
A 24 s, 20; 18! 201 100: 2c: Si 351 121 141 23! 2C E1 
s- 19: 91 1r · 1s: 23, ·72: 1r s: 33 1c, 13' 23: 16' 10: ·zci' 
C 23! if 17 · 1s, 21 93 ii j! 27 61 1 23! li 181 
A- 231 11 20, · 1sr 20: §Tl 1s, s' 37··121 ,if 2:'l: 18, 6, 16 
s- :ff 10T 1§' 1f z4r ?a: za: :s: 34: ii, is' zf 20 s: 191 

~+ ~~i 1~i i~; i~f i~: ~~11~: ~: ~i; i~i 1t i~i i:: 101
. 1~1 

o 22: 1: 11: 121 i;; ss!"····g;- sT 20: 91 ar z:r 1 T ····· 1 ~i 16' 
C+ 18' 81 19! 1iii 21 s~r:12\ 4( ?7' 9: is! z3( 3j ... 1.8 



·"·~---------l---1----1----'---'--_,__ _ ___. __ _,__---! __ _._ _ _j. __ ..._ _ _._ __ .__...__-' 

S )ntl ................................................. . ..... ._: ...................................... , si:uderii 2· ........ .. . 
siucterii :'l 
···················· 
Student 4 

. ........................ , ..................... . 

·+········ ················ ········:········ ........ ! ...................................... '. 
. .............. ········= 

Student 5 ............... 
Student 6 . ...... : ........ .l. ....... ........ \ ........ -....... . ·············· Student 7 .............. ..... ; ........................ ; ........ , ........ ; ........ ! ................. J. ....... . 
Student 8 .............. 
Student 9 ....... ; ........ l ....... . L ....... .L ........ ................................. . 



\ 

Teach er: MRS. WONDERFUL 
Class: MATH 
Cass Summary by Cateqory 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

"% ~· ·Cat." is the percent of total points possible in this category. 
"% of all" is the percent of the total points possible in all categories. 

ASSIGNMENTS [30] QUIZES [25] \TESTS [ 40] 'ASSIGNMENT SHEE ... ( 
(30.00%) (25.00%) !( 40.00%) (5.00%) 
% of cat. % of all% of cat. % of all]% of cat. % of all% of cat. % of alli 

Student 1 A 93.38% 28.01% 94.57% 23.64%! 100.0% 40.00% 100.0% 5.00%/ 
si:i.iei,,.rii: z · · s- · 9 i :o3%. · · ·21·_3; 01o · · · ·s4j, o/; · ·· z i :oso/oi · · iii.00% · · "zs:soo/c ·· · ·, 00:0% · · · · s·:00%: 
Student 3 . . . C ...... 79.49% z:i:85% ... 62:20% "i 5.5.So/J 9:i:00% :J1:2oo/c . ,i0.00% ... i:00%! 
si:'i.ieierii:·4·················i,::···· ···s1:ii2%···;,:6.':i'so/c·· ·si22%···22::ioo/J .. iii .00%··3(i.4oo/c ··· 100:0%· ·· s·.ooo;J. 
·si:uc1erit·s··················s:···· ···'s3.9i% ···2s:i9% · ·g; :i"s%··22.19o/J. ·1a:ooo/;···ii :2oii ·· i 00·.0%·· · s:ooo/J 
si:'i.ieierii:6··················s······ ···a6:s4% .. 2s.96o/c····si:2s%·· zi:sio/i. il·s.00%· 3s.oo% ·40:00%···2.aa.;J 
si:uc1erit 1··············· .. ·s+···· ····9·o.::is%·· 21:i 2'* ···so.':lii%. 20.ioo/J. ··90:00%· 36:ooo/c ···i oo.o%··s:ooo/J. 

.·~r~~:·~~:·l:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:.:·§~:·:·:·:·: ··:·:l·;:{t~:·:·:·:it:~i~··:·:·ti:tt~·:·:·:·1:1:ii~·:·:·:tt::gg~:·:·:·t~:ig~:·:·:·~·g·~ot~·:·:·:·:·:i::gg~ 



?' Teacher: MRS. WONDERFUL 
V Class: MATH 
..- Assionment Summary 

"11. Title Date 

Category "ASSIGNMENTS" 
1 Ip 34 1/27/92 
2 P. 111 5-14 * 1/27/92 
3 I P 36 l /28/92 
4 i p 37 1/29/92 
5 p. 118-119 1-3 * , 1/31/92 
11 p.131 5-12; 132 10-17 \ 2/14/92 

' 12 P 40 i 2/14/92 
15 p. 151 1-10 i 2/27/92 

Category "OUIZES" 
7 P. 1 26-1 27 * I ~;; ~;~~ 9 CUMULATIVE REVIEW 
10 p.131 skills review I 2114;92 
13 P. 139 CHAPTER CHECK I 2119;92 
14 p. 145 reading math i 2/24/92 

Category "TESTS" 
6 I CHAPTER 3 TEST j 2/3/92 

Category "ASSIGNMENT SHEET" 
8 I Assignment Sheet 12/10/92 

Poss Obi% 

24 70.00 
10 70.00 
20 70.00 
18 70.00 
25 70.00 
16 70.00 
23 70.00 
20 70.00 

20 ! 70.00 
40 i 70.00 
12 J 10.00 
20 I 10.00 
10 i 70.00 

\ 100 I 10.00 

i 5 i 70.00 
' 

Mean 

19.67 
8.22 
18.33 
16.56 
20.11 
11.11 
23.00 
17.50 

i 16.33 
: 30.22 
: 10.11 
i 18.14 
! 7.00 

! 84.33 

\ 4.11 

WALTER STROM 
CLE ELUM/ROSYLN SCHOOL DI 

Med. Obiective 

! 22.00 
! 8.00 
: 19.00 
: 18.00 
! 21.00 
! 13.00 
! 23.00 
\ 18.00 

! 17.00 
! 33.00 
j 10.00 
! 18.00 
\ 8.00 

i 90.00 

i 5.oo 



LESSONS 

Pull Down Menu Features 

* INSTRUCTIONAL HINTS 
Have all participants bring gradesheets they have created. 
Hand out material covered on lesson sheets at the independent practice stage of the lesson. 

1. Anticipatory set 
Have students load a file. 
Review any aspects of the program covered which are unclear. 
Discuss the need to be familiar with the features available in this program. 
Discuss the "user-friendly" format of Macintosh programs. 

2. Objective 
Students will be familiar with the variety of features available in using the gradebook 
program. 

3. Direct Instruction 
4. Modeling 

Present the different Menu options available with the Gradebook program and what each 
Menu has to offer: 

1) File 
2) Edit 
3) Sort 
4) Options 
5) Reports 
6) Windows 

5. Monitoring to check for understanding 
Discuss the different menu options and the advantages/disadvantages of them. 
Question whole group on steps needed to complete the task. 
Take responses from individuals. 

6. Guided Practice 
Have all participants experiment with the six (6) Menu selections available. 

7. Summary 
Further discuss the different menu options and the advantages/disadvantages of them. 
Discussion to establish trouble spots. 

8. Independent Practice 
Hand out Lesson sheets which follow for participants to practice material covered. 

* Request an evaluation from each participant to establish material that might need to be 
presented differently. 



PULL DOWN MENUS 
; File Edit Sort Options Reports Windows 

File Menu 

Edit Sort 01 

New 3€N 
Open ... 3€0 

Close 
Saue acs 
Saue Rs ... 

Import Students 
EHport Students 

Page Setup ... 

Quit 31:Q 

New 

Open ... 

Close 

Save 

Save as ... 

Import Students 

Export Students 

Page Setup ... 

Quit 

Creates a new file. If an 
existing file is open, 
Assignments, Students, 
Categories, Grade Scale, 
Teacher, Class Name, and/or 
Password may be copied to the 
new file. Allows open file to 
be saved before new file is 
created. 

Enables you to choose a 
Gradebook file to open. 

Enables you to close a file that 
is currently open. 

Saves the current version of 
the file. (May use acs ) 

Enables you to create a name 
for a file and select where the 
file should be saved. 

Transfers student names from 
an existing database. 

Transfers student names to a 
text file used by a database 
application. 

Enables you to create your 
own specifications for the 
printing of reports. (Much like 
when using a word processing 
application. 

Enables you exit Gradebook. 
Lesson 8 - page 1 



Edit Menu 

Sort Options R, 

Undo 3€2 
Undo, Cut, Copy, These applications are not 

Paste, and Clear available for use when using 

Cut aGH the Gradebook program. 

Copy aGC New Student Allows input of a new student Paste aGU or student information. 
Clear 

New Student 3«T New Assignment 
New Assignment 3«B 

Creates a new assignment or 
allows modification of 
assignment information. 

Edit Student 
Edit Assignment Edit Student Allows changes in student 

information after clicking on a 
student's name. Browsing 
through existing student list is 

Edit Categories aflG 
Edit Comments aflM 

Delete Student 
Delete Rssignment 

also an option. 

Edit Assignment Allows changes to be made to 
an existing assignment after 
clicking on an assignment box. 

Fill Scores... aflE 

Browsing through existing assignments is also an option. 

Edit Categories Allows modifications to the category 
listing. 

Edit Comments Allows addition, deletion or 
modifications of standard comments. 

Delete Student Enables you to remove a student 
from the file. ( click on student 
before selecting) 

Delete Assignment Enables you to remove an assignment 
from the file. (click on assignment 
before selecting) 

Fill Scores Enables you to fill all scores with one 
particular grade. It can also be used 
to fill all unscored boxes. 
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Sort Menu 
Options R 

.,; Name Entered 
First Name 
Last Name 
Raw Percent 
Final Grade 
Track 
Scan Order 
ID 

Name Entered 

First Name 

Last Name 

Raw Percent 

Final Grade 

Track 

Scan Order 

ID 

Alphabetizes the class list by 
the first letter oas student was 
entered. 

Alphabetizes the class list by 
first name of the student. 

Alphabetizes the class list by 
last name of the student. 

Arranges the class list from the 
highest to lowest average Raw 
Percent. 

Arranges the class list from the 
highest to lowest according to 
Final grade. 

Arranges the class list by the 
track students are assigned. 

Arranges the class list from the 
first name entered to the last. 

Arranges the class list by the 
ID number assigned to the 
student. 
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Options Menu 

Options Reports Win 

Setup... 3€U 
Rssignment Info 3€1 
Grade Distribution 
Recalculate WR 

Scan Class Forms .. . 
Scan Test Forms .. . 
Create Key ... 

Find Student ... WF 

Setup Enables you to enter 
Teacher and Class Name for 
reports. Enables the input of 
a grade scale, password, 
categories, and preferences 
for a file. 

Assignment Info 
Shows a distribution of 
grades and other statistics. 

Grade Distribution 

Recalculation 

Displays distribution of student 
grades according to established 
grade scale. 

Manually calculates the grade 
with existing scores. 

Scan Class Forms 
For use when scanning. 

Scan Test Forms 

Create Key 

Find Student 

For use when scanning. 

For use when scanning. 

Searches for a student through 
class list. (by name, portion of 
name, or ID) 
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Report Menu 

Windows 
Grade Report ... 
Student summary .. . 
Objectiue Report .. . 

Paper GradeBook .. . 
Class Roster ... 
Names on Scan Form ... 
Class Summary by Category 
Rssignment Summary ... 
Deficiency Report ... 
Student Objective Groups ... 

Paper Gradebook 

Class Roster 

Grade Report Prints final grade information 
for an individual student. 
Multiple files may be 
combined into a single report 
for one or more students. 

Student Summary Prints a summary of the scores 
for an individual student or 
several students. One than one 
file can be generated at a time. 

Objective Report Prints a list of objectives 
mastered or not mastered for 
students selected from one or 
more files. 

Prints the Class Scores screen including student 
names, final grades and scores for the entire file. 

Prints your class list on a grid with 19 empty 
squares. (I use this for checking off various forms 
assignments or permission slips) 

Names on Scan Form For use when scanning. 

Class Summary by Category Prints teacher's and class name at top. 
Then gives a listing of (% of Cat.) the 
percent of total points possible in that 
category and (% of all) the percent of 
total points possible in all categories. 

Assignment Summary List the Name, Date, Points Possible, 
Expetation percent level, Mean, Median 
and Objective for each assignment in 
each category. 

Deficiency Report Produces a list of students who have a 
weighted percent above or below any 
entered amount. 

Student Objective Groups Creates a list of students who have met 
teacher expectations on objectives within 
a selected unit. Lesson 8 - page 5 



Windows Menu 

lllindoms -----~ Class scores This is the screen which 
appears when a file is initially 
opened. It displays students, 
their scores, and final grade. 

Class Scores a!: 1 
Student Summary a!:2 
Categories a!:3 

Student Summary This screen enables you to 
view an individual student's 
scores on every assignment in 
every category. It also gives 
the student's final grade, 
weighted percent and raw 
score. Scores may be changed 
at this screen. 

Categories All categories and their 
weights are displayed. All 
assignments are displayed in 
their respective categories. 

Lesson 8 - page 6 



CHAPTER 5 

Summary, Conclusions and Recommendations 

Summary 

The Cle Elum-Roslyn School District, in addressing the 

restructuring process for their Creating the Future project 

began investigating its curriculum. In that exploration 

came an interest in Outcome Based Education. 

One of the key components in Outcome Based Education is 

the integration of curriculum objectives, student outcomes, 

and tracking of student progress in achieving educational 

objectives. The need to compile this data so that it can be 

easily accessed, interpreted and channeled in a way to 

facilitate the teacher, lead to inquiry of an appropriate 

database to achieve this end. 

The district chose to explore the computerized program, 

trACE™. The trACE™ program has a number of components which 

are beneficial to a teacher in assessing student abilities, 

outcomes and needs. An added feature of this program is the 

Curriculum Navigator component which integrates all these 

areas together. 

The author was sent by the district to one week of 

intensive training in the trACE™ program. Interviews were 

held with the creators and trainers of the program 

indicating that the trACE™ Gradebook could be a tool for 

record keeping. Following the training, the gradebook 

30 
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portion of the program was piloted within one classroom at 

Walter Strom Middle School. The development of a 

presentation to demonstrate the various aspects of the 

gradebook was presented. Teacher interest and inquiries 

made instruction a necessity, and resulted in the need for 

lesson development for training. Course evaluations upon 

completion of the project training indicated that 

computerized record keeping of grades was a benefit to 

teachers. Some of the benefits mentioned were conservation 

of time, ease of grade calculations and updated reports of 

student progress. 

Conclusions 

In conclusion, the implementation of the technology and 

the Gradebook portion of the trACE™ program has been very 

successful at Walter Strom Middle School. Through this 

process every classroom has become equipped with a Macintosh 

teacher station. Classroom teachers of Walter Strom Middle 

School expressed in the course evaluations that they 

believed their computer literacy improved dramatically as a 

result of having a computer station and completing the 

gradebook training course. (Refer to Appendix C) The 

trACE™ Gradebook is currently being used by all classroom 

teachers. The music and physical education teachers, who 

are itinerant, are not using the Gradebook program at this 

time. 
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Through this involvement in the use of the trACE™ 

Gradebook, twelve teachers of Walter Strom Middle School 

have committed themselves not only in time, but financially 

by purchasing Macintosh home based-computers of their own. 

Recommendations 

After considering the expectation of this project, 

reading the literature for record keeping and working with 

the staff of Walter Strom Middle School, it is recommended 

that: 

1) the presentation of the Gradebook component of the 

trACE™ be viewed by teachers to create interest in 

pursuing the training and use of an electronic 

gradebook program; 

2) teachers currently using the program should use 

the presentation for communicating their grading 

process to students and parents; 

3) instruction of the gradebook portion of the trACE™ 

program be an intensive workshop with all aspects 

of the gradebook presented, followed by a couple 

review sessions; 

4) teachers become trained in the Curriculum 

Navigator component of the trACE™ program, to 

integrate their curriculum and gradebook; and 

5) school-wide use of the trACE™ Gradebook be used 

for report cards. 
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trACETM 

trACE™ 

teacher resources to 
Achieve Classroom 
Excellence 
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Components of the 
tr ACE™ program: 

• Curriculum Navigator 

Components of the 
tr ACE™ program: 

• Curriculum Na vi gator 

• Gradebook 
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) 

Components of the 
tr ACE™ program: 

• Curriculum Navigator 

• Gradebook 

• Calendar Generator 

Components of the 
tr ACE™ program: 

• Curriculum Na vi gator 

• Gradebook 

• Calendar Generator 

• Rollbook 
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Common 
questions asked 
regarding the 
trACETM program. 

??????????? 
• • • • • • • • • • • 

How much does the program cost ? 

Program - 1 station 
add 

2 - 10 stations 
11 - 20 stations 
21 or more 

$ 1000.00 

450.00 
800.00 

1000.00 
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What type of equipment is needed ? 

The trACE™ program will run on 
a 1 MB Macintosh ( with hard 
drive). It can be run on a single 
machine or it can be placed on a 
network with a file server, to reach 
as many users as needed. 

Where do the program materials 
originate? 

Alpine School District, following 
their state guidelines created the 
curriculum which is contained on the 
CD. 

The program materials were 
developed to establish a unified 
curriculum and a resource to 

44 



Committees were formed of teachers and 
administrators who developed the scope 
and sequence of the curriculum which 
was then inputed into the computer. 

There are areas such as State History 
which are not applicable by other states, 
but it contains a general curriculum that 
can be used in all states. 

Does the program provide for 
curriculum changes ? 

YES. You can add any objectives that you 
would like to. For example Washington 
State History objectives may be added. 

In addition to this lesson plans (strategies) 
and worksheets (supplements) may be 
created to complement the objectives. 
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Is it set up with Outcome Based 
Education (OBE) principles ? 

YES. The entire idea of trACE™ was 
set up on Outcome Based Achievement. 
The term objectives is used, but is 
interchangable with the term outcomes. 

The Curriculum Navigator portion of the 
program has the ability to select student 
mastery or curriculums by outcome 

trACE™ 

Grade book 
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• 

• 

File Edit Sort by Windows 

Grode Scole District I 
R+ % School \wnLTER STROM 

R 95 % Te ocher J MRS. WONDERFUL 
R- 90 % Subject JMRTH 

'7. B+ 88 

B 85 % 
B- 80 % 
C+ 78 % [ Possword ... ) SET- UP 
C 75 % [ Cotegories •.• ) 

70 % c-
% 

Prefs ... 
D+ 68 

D 65 % 

o- 60 % 
11 r~r .. nrnl 1 Ir nv 

File Sort by Options Reports Windows 

Wt. Cotegory 
30 RSSl6NMENT\ 
25 QUIZES 
40 TESTS 

5 RSS I GNMENT SHEET 

Totol Weight I 00 

Entering Categories 

~Weight 

@=J Number of High scores to drop 

EJ Number of Low Scores to Drop 

D Make Highest Score the MaHimum 

D EHtro Credit Category 

( Delete ) 

( Undo Chonges J ( New J 

( Concel ) ( Rccept B 
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Entering Students 

s File Sort by Options Reports Windows 

Student Information 

standard Comments: 

Standard comments 
may be written in and 
used on various 
reports. 

[ Edit Comments ••• ) 

Name / 

ID .,,12=3~~-~ 
Track~ 

lndiuidual Comment: 

t8l Use Letter grade in reports 

[ IJtult> [ hn111_1es J ( New J 

Cancel ] ~¢;;;;;;;n~c~c~e~p~t~D 

Entering Assignments 
Options Reports Windows 

Category: 

ASS l&NM[NTS 
QU12ES 
TESTS 
ASSIGNMENT SHEET 

[ Edit Categories ••. ] 

Assignment Nome I New Assignment 

Date Jo/15/92 
!=====~ 

Points Possible j 100 
!=====~ 

EHpectation Leu el (%JI~ 7_0_.o_o ____ ___, 

[Clear][ Objectiue .•• ] (no objectiue) 

OTest 
Info ... 

( Un1!0 I: hontJt~s J New 

[ Cancel All l n Accept I 
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Entering Scores 

M•thod: ,.. P. 11P36 37 .1HCHAP'P.12tAssi 1CUMU .131 

.~.r:~,.~?.~~ ........... ..l.~:. 19J al 101 1el 20! 741 1a1 3\ 21\ a a v · · a .... 2:f .... i;T ... ia!" .. if .... 24T ... s1T···1'rT .... i: .. ·2iiT ... ii --~-~i:-, .. ~9~ ............ / ... -:-. 

Le•, Madonna ! A 24! 8! 20j 18! 20j 100j 20! Sj 35j 12 !iiiii 

•f :~f ;ftf ff f:.:.:: t ~\: : : : ~it:: ::it:: it!•:: il ft:: iii:• lti:.: •tit.::: it:: •i!l::: :~; llllll 
Pan Peter- i A- 24i 101 201 18i 22i 1001 t 9i 51 291 12 Will h:i;~jn.;:H•~~: :: ::::I~~:: : :::2~J::::iiT:::1:t:::1(:::~f: ::9~[: ::~!iT::::sI :::3~[:::(a mm 
Re Ron !8- 24! 10! 19! 18! 23i S4i 16! 2! 31! 10!!/i!i 

o ...... ~ .. 1 .. 1•~ ::~~:· ::::~~r::,1r:::~~r::!1r:1~:r::~zr:::1~:1:::::~r::~i1::::1:1 l!i 

~I demo2 - Student Summory 

Blossom, Apple- Letter w,mted Rav 

!)f;; Final Grade: I A- I 90.30 92.4 I Category: !All . 
Cab, Johnny 
Chaplin, Ch.rli< 

I 
• Title Date Ser Poss Obi'il Mear Med. at Obieetive 

Christmu I Mar1:1 1 P 34 1 /27/' 24 24 0.00 &5' 2.5 1 
Clost, 01,nn 2 P. 111 5-14 1 /27/' 10 10 70.00 7.91 8.50 1 
Davis, Betty 3 P 36 1 /28/' 18 20 70.00 16.9 17.51 1 
Duck, Donild 4 p 37 1129/' 18 18 70.00 !6.3t 18.0 1 
Gr>nt, Amy 5 p.118-1191- 1 /31 /' 24 25 i7D.OO ~0.5' ~1.0 1 
lff, Midonni 6 CHAPTER 3 TE 12/3/9: 90 100 170.00 ~3.S. ~9.01 3 
M¥1tlf., Mick•g 7 P. 126-127 • 12110/' 20 20 170.00 16.4" 17.01 2 
Moust, Minnre 8 Assignm,nl Sh 12/10/! 3 5170.00 4.09 5.00 4 
N•lson, Willit 9 CUMULATIVE R 12/to/s 37 40 170.00 ~0.3' ~0.01 2 
Nolte, Nick 10 p.131 skillsr• 2/14/' 9 12 170.00 8.82 ho.a, 2 
P.¥1 1 Ptttr 11 p.131 5-12; 1 12/14/S 11 16 170.00 11.3< 12.s, 1 
Poppl\S I Mary 12 p 40 2/14/S 23 23 170.00 22.5 123.01 1 
Rn9tn, Ron 13 p. 137 7-25 2/18/S 19 19 [70.00 16.0! 17.01 1 
R..d Rex 14 P 42 2/19/S IS 16 70.00 13.4 15.0 1 

IS P.139CHAPTI 2/19/S 18 20 
Ruth, Babe 

170.00 17.4 18.01 2 

Up, Mark -



demo2 - Categories 

UIZES 25 TESTS 

P 34 P. 126-127 • 1-::CH'.":-:AP:,::TE::-:R 3:"::TE::,S ~ t-:-:-~~ 
P. 111 5-14• CUMULATIVERE 
P 36 ·.;:. p.131 skills rev 
p 37 .? P. 139 CHAPTER 
p.118-1191-3 mm p.14Sreading 
p.131 5-12; 13 :::;: 

P 40 """ 

The Gradebook component of the 
trACE™ program offers a variety 
of report formats which assist with 
classroom organization, and 
instructional planning, as well as 
those which will be sent home with 
students or utilized in conferencing 
with parents. 
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Reports Windows 
Grade Report ... 
Student Summary ..• 
Objectiue Report ... 

Paper GradeBook ... 
Class Roster .•• 
Names on Scan Form ... 
Class Summary by Category 
Assignment Summary ... 
Deficiency Report ... 
Student Objectiue Groups ... 

Grade Report -final grade information by individual student 

• Teacher: MRS. WADEIKIS 
v 
T Grade Report for Minnie Mouse 

Re-port Period: '5/6/92 - 6/8/92 

Subject .ind Teacher 

LANGUAGE Grad.: 
MRS. 'vi ADEIKIS Class Avg: 

MATH Grade: 
MRS. 'w'AOEIKIS Class Avg: 

READING/SP ••• Grad.: 
MRS. 'vlADEIKIS Class Avg: 

Current Re~ 

90.50\ll A-
84.577" 

85.71'JI B 
83.447" 

94.01 'Jl A 
88.687" 
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Stud~nt Summarx - scores by individual student 

... Teacher: MRS. WONDERFUL 
v Class: MATH CLE ELUM/ROS ...,. Student Summaru for Minnie Mouse 

Grade: 91.23'.ll (A-) 
Ch1ss Avg: 82.48ji! 

• Title Date Ser Poss QQi~ ~jectivE' -
Ca\•92!:Y "ASSIGNMENTS" 

1 ; P 34 1 /27 /92 22 ; 24 j 70.00 
2 \P. 111 S-14• 1 /27 /92 10 \ 10 \ 70.00 
3 / P 36 1 /28/92 19 ; 20 ; 70.00 
4 / p 37 1 /29/92 18 ! 18 \ 70.00 
s (p.118-1191-3• 1/31 /92 24 \ 25 \ 70.00 
11 i p.131 S-12; 13210-17 2/14/92 15 / 16 j 70.00 
12 j P 40 2/14/92 22 \ 23 j 70.00 
13 j p. 137 7-2S 2/18/92 18 \ 19 \ 70.00 
14 j P 42 2/19/92 16 j 16 j 70.00 
16 i p 43 • 2/21/92 15 i 15 j 70.00 
18 [ p. 147 7-21 2/25/92 13-. j 15 \ 70.00 

Student Summary 

20 j p. 151 1-10 ! 2/27 /92 20 j 20 ; 70.00 

Ca\eg!![y_:'..QUIZES" 
7 , P. 126-127 • 2/10/92 20 , 20 70.00 
9 i CUMULATIVE REVIEW 2/10/92 36 i 40 70.00 
10 \ p.131 skills review 2/14/92 7 i 12 70.00 
15 \ P. 139 CHAPTER CHECK 2/19/92 20 \ 20 70.00 
17 ( p. 145 reading math 2/24/92 4 j 10 70.00 

Categ!!!'.Y "TESTS" 
6 ; CH APTER 3 TEST \ 2/3/92 \ 91 ; 100 \ 70.00 

Categ!![y "ASSIGNMENT SHEET" 
8 \ Assignment Sheet , 2/10/92 : 5 \S , 70.00 



Objectjye Report -a listing of objectives mastered or 
not mastered for an individual studer 

Paper Gradebook - class scores including student names, 
final grades and scores for the entire cla 

Class Roster - a listing of the entire class on a grid of 
19 squares for recording purposes. 

Names on Scan Form - student's names and ID are listed 
for use on scan forms. 

Student Objective Groups - a listing of students who have 
mot to.n,...haT" o.v-r,,a,-,.t"r'Jt~..,,nc, f"\n 

Class Summary by Category -percentage of points possible 
in each category by class. 

Teecher: MRS. WONDERFUL 
Cless: MATH 
Cless Summm,J b4 C8teqo~ 

",S o( cat." is the percent o( total points possible in this c.ategor-y. 
",S: of all" is the percent of the total points possible in all categories. 

CLE El 

ASSIGNMENTS [30] !OUIZES [251 !TESTS [401 • 
(30 .00911) !(25 .00911) !( 40 .00911) :, 
911ofc,t. 911ofo1]!911ofc•t. 'lllof•ll!'lllofc•t 96of,11!' 

~?~"- -~~'- .............. c~ ..... J3 .. ~.~'?! .. . n, n·i( .. 7.1.-.~~~ ... 1, .. n'lll! .. 74.-9.Q'?! ... ,,~ ,9Q\'!l 
\'.?9!.~~-~~ .............. B~ ..... !12 .. ~.1 '/! ... 2.4 .~!\~L .7?.-.4 ).~ ... 1. ?.-~-~?!!L. !11 .. 9.Q'/! ... 3.4,41'.l~l 
~PP.1~. ~1.~~~~.m. ........ c~ ..... JQ .. 3.~'/! ... 2.!, 12\'i!l .. 92-.49.~ .. .1. ?.-;\~%).. ?.1,9.Q%. ... 3.~,4Q'1i!l 
~?~. ~-·~~- .......... B.-....•• ~2 .. ?.?\I! ... 2'!,7:Z'/!l .. ?;\,~?.~ ... 1 ~-~2.'llli.. ?.9,9.Q'/! ... 3.~ ,4R~l 
~h•r_li•. C_hapli~ ........ o~ ..... ~ 1 .. 9.s'/! ... ).~ ,32\'i!l .. ~.1.-.42.~ .. .1. 2.-!19%L. ~7 .. 9.Q'/! ... 2.~.~Q'/i!l 
l".1:'!.Y. ~.hri~l(l)~S ....... B:': .... !18,3.~%. ... 2.s,~.1.'/ili. _8J .. 4?.~ ... 4L-~1 %L. ?.? .. 9.Q%. ... 3.~ ,QQ~l 
~l~ru.>. ~-l~S! ........... -~- ..... -~? .. ~-~'?! ... 2.~ ,7:Z'/!l .. ~fl-.~?.~ ... '..l9.-.1.9%L. ?.9 .. 9.Q%. ... 3.~,9Q1i!l 
B•tly_ [)avis. D . 80.0.896 . 24 .02911, 61,.76.96 15.4496!. 58 .OO'lll 23.2096, 
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Assignment Summary -listing of points possible, mean and 
median for all assignments. 

...,.. Teocher. MRS. WONDERFUL 
'v Closs: MATH CLE ELUM, ...,.. AsS1 tSLKT'INITTJ 

! !!!k 2.!.!.t - Q;i'.!i --£i!!:9!!:Y • ASSIGNl1'HTS-
I : p 34 j 1 /27/'9'2 \ 24 j 70.00 ! 20.5'5 122,0 
2 ! P. 111 S-14 • l 1 /27/92 i 10 ! 70.00 !7.91 ; 8.50 

' j P36 / 1/28/'9'2 ! 20 l 10.00 l 16.91 ! 17.50 

• l p37 i 1 /29/92 i" j10.oo ! 16.36 118.00 • !p.118-1191-3• 1/61/'2 12' I 70.00 ! 20!!9 21.00 
II , p.131 s-12; 13210-11 Ii~~:~;; i 16 I 10.00 l 11.34 11250 
12 IP'° ! 23 !10.00 i 22.59 23.00 

" i p. 137 7-2'5 2/18/92 j 19 [ 70.00 ! 16.os j 11.00 

" ! P 42 ( 2/19/'}2 ! 16 ! 70.00 I 13.48 I tS.00 

" j p 43 • ( 2/21 /92 I 1s i 70.00 j 13.47 j 15.00 

" i p 147 7-21 ; 2/2'5/'92 J 1s i 70.00 i 10.89 112.00 

" jP~ ( 2/26/'92 i 20 i 70.00 i 16.28 ! 11.00 
20 ! p. 151 1-10 ]2/27/92 j 20 i 70.00 i 17.20 ! 17.00 

~~ 
7 'p 126-127 • , 2/10/'.12 i 20 i?0.00 j 16.43 117.00 , ! CUHU.,t,.TN[ REVIE'I,' [ 2/10/92 i "' ! 70.00 j 30..36 110.00 
10 Ip.Ill $1o:ilknvM,,.. 2/H/92 ; 12 110.00 i 8.82 ! 10.00 .. P. 139 o-lAPT!R CHEO: : 211,tn i 20 . 70.00 i 17.+4 j 1e.oo 
17 ( p.145rudlrtljrNth ( 2/2'4/92 j 10 j10.oo j 7 .16 1a.oo 

~920,l...:::run: ':,.,,.,..... " ' .......... Tn> ... .,..,.,. .. 
. ..,n,.,., 

1 ..... - ·-= 
Deficiency Reuort -a listing of students who have a weighted 

percent above or below an entered amount 

Choose a deficiency leuel 
(a final percentage 
between O and I OO). 

A student summary 

Leuel: lillJIII\ IC- ..-1 for each students 
below the 

0 Aboue leuel 
expectation will 

Print students then be generated. 
@ Below leuel 

( Cancel ) (( OK l) 
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Toe trACE™Gradebook was developed by 
teachers to provide relevant information 
about student progress to assist in making 
educational decisions. 

Not only is the standard type of grade 
information recorded, but Gradebook also 
monitors student progress toward mastery of 
curriculum goals or outcomes. 

Toe teacher is able to modify and adjust 
instruction based upon this feedback. 

This presentation was created by: 

Michele W adeikis 

A special thanks to Scott Adolf for his 
technical support. 

And to the developers of the tr ACE™ 
program, thank you for an excellent teacher 
resource. 
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SYLLABUS 
ED 500 

COMPUTERIZED GRADEBOOK 
Instructor: Michele Wadeikis 

Phone Number: 649-3560 

Course Description 
This class will be an introduction to a gradebook program. trACETM gradebook 
was developed by teachers to provide relevant information about student progress 
to assist in making educational decisions. The course will include the following 
units: Creating a new file, file set-up, entering students, entering assignments, 
entering scores, and the printing of various reports. 

Purpose 
To provide teachers with a tool for tracking student progress. 

Materials 
A copyright program will be used for classroom instruction and may be 
purchased independently. 
[trACE™, Alpine School Disrict] See instructor for details. 

Class Meeting Times 
Jrst class is Tuesday, February 9th. 

See calendar for class dates. 
Class will be held from 4:00 P.M.to 7:00 P.M. 
Walter Strom Middle School - Room 9 

Final class is held on Tuesday, March 9th. 
* Alternate meeting times may be agreed upon by instructor and class members. 

Student Leaming Objectives 
Students will: 

create a new file 
set-up a file 
enter students 
enter assignments 
enter scores 
print various reports 
demonstrate and utilize a gradebook set-up for their students 

) 

Course Requirements 
Attendance 30 pts 
Quizzes 10 pts 
MidTerm 15 pts 

Grading Scale 
94+ A 
90 + A-
87 + B+ 

Final Exam 20 pts 84+ B 
Final Project 25 pts 80 + B-
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Date: March 8, 1993 
To: trACE™ Training Participants 
From: Lee Maras 60 

Please take a minute to answer the following questions regarding your 
recent computer training. Please feel free to comment when necessary. 

This information will be compiled to determine if the trACE™ Gradebook 
will be implemented building-wide. 

1 ) Do you feel your computer literacy has increased after training with 
the trACE™ Gradebook? 

YES (10) NO (1) 

COMMENTS: increased my literacy dramatically; with my present level of literacy, program 
was easy to operate. 

2) Do you feel your computer usage has increased ? 
YES ( 1 0) NO ( 1 ) 

COMMENTS: Tons!; I need my own teacher station. 

3) As compared to a written grade book, do you feel that a computerized 
gradebook 

is more accurate ? YES (9) NO (2) 

is less time consuming ? YES (10) NO (1) 

grade calculations are quicker ? YES ( 11) NO (0) 

COMMENTS: Saves lots of time ! ; They are equally accurate; Less human error; Borderline 
students are hard to track (B- or C+ ); easily accessed for parent conferences. 

4) Were the handouts provided helpful during training ? 
YES (9) NO (2) 

COMMENTS: Hands-on more beneficial for me; well-written, easily read, easy to transfer 
information, "user friendly", 

5) Will you continue to use the handouts ? 
YES (6) NO (5) 

COMMENTS: Information is easily absorbed. Excellent resourse for future use, Probably just 
ask for help. 

6) Do you plan to continue to use the trACE™ Gradebook for your grading 
needs? 

YES (11) NO (O) 
COMMENTS: DEFINETL Y !! Great for student and parent communication ! 



KITTITAS COUNTY 
STAFF DEVELOPMENT 

EVALUATION FORM 

0 

!ITLE OF WORKSHOP/ ACTIVITY COMPUTERIZED GRADEBOOK INSTRUCTOR 

61 

WADEIKIS 
LOCATION W.S.M.S. QUARTER/YEAR WINTER '93 YOUR NAME (OPT.) ___ _ 

PLEASE EVALUATE THE WORKSHOP/ACTIVITY YOU HAVE JUST COMPLETED. 

1. WERE THE OBJECTIVES STARTED CLEARLY? CLEAR 5 4 3 2 VAGUE 
(9) ( 1) 

2. WERE THE OBJECTIVES MET? FULLY 5 4 3 2 1 LITTLE 
(10) 

3. DID THE INSTRUCTOR PROVIDE RELEVANT EXCELLENT 5 4 3 2 1 POOR 
MEDIA AND ACTIVITIES? (1 O) 

4. WERE THERE DEMONSTRATIONS BY THE AMPLE 5 4 3 2 1 NOT 
PRESENTER WITH OPPORTUNITY FOR YOU (1 O) ENOUGH 
TO PRACTICE AND RECEIVE FEEDBACK? 

5. DID THE ACCOMMODATIONS HELP OR HINDER HELP 5 4 3 2 1 HINDER 
THE MEETING OF OBJECTIVES? (7) (3) 

6. WHAT I FOUND MOST USEFUL: using a computerized gradebook. letting me know who is below expectation 
level. direct application of program. increased comfort with Mac. quicker. up-to-date method of 
sharing grades with students. Using what we did in class .• Very relevant. Marvelous tool for the 
classroom teacher. it provides immediate feedback on student scores. Handouts provided .• ease of 
using a Mac and time saving gradebook. Hands- on practice !. Enhanced my use of technology. 

7. WHAT I WOULD LIKE MORE OF: Additional training. class to mesh with our individual teaching assignments. 
More use of the other components of trACE. such as the curriculum aspect (another course) 
Excellent presentations ! More time to discuss problems and solutions. 

8. WHAT I WOULD CHANGE: Not use the file server. nothing! 

9. OVERALL RA TING OF THE COURSE: OUTSTANDING GOOD AVERAGE FAIR POOR 

10. 

11. 

5 4 3 2 1 
(9) (1) 

OVERALL RATING OF THE INSTRUCTOR: OUTSTANDING GOOD AVERAGE FAIR POOR 
5 4 3 2 1 

She's Great ! ( 1 0) 

OTHER TOPICS YOU WOULD LIKE TO SEE OFFERED BY STAFF DEVELOPMENT: 

HyperCard. Classroom Management. Laser disc technology. Video disk. At-risk. self-esteem. wellness. 
DataBase uses for students and teachers. 
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